SCE Training Curriculum
Siemens Automation Cooperates with Education (SCE) | 09/2015

PA Module P03-03
SIMATIC PCS 7 – Batch Control
Matching SCE Trainer Packages for these curriculum

- **SIMATIC PCS 7 Software block of 3 packages**
  Order No. 6ES7650-0XX18-0YS5

- **SIMATIC PCS 7 Software block of 6 packages**
  Order No. 6ES7650-0XX18-2YS5

- **SIMATIC PCS 7 Software Upgrade block of 3 packages**
  Order No. 6ES7650-0XX18-0YE5 (V8.0 → V8.1) or 6ES7650-0XX08-0YE5 (V7.1 → V8.0)

- **SIMATIC PCS 7 Hardware Set including RTX Box**
  Order No. 6ES7654-0UE13-0XS0

Please note that these trainer packages may be replaced with subsequent packages.
An overview of the available SCE packages is provided at: siemens.com/sce/tp

**Continuing education**
For regional Siemens SCE continuing education, contact your regional SCE contact partner. siemens.com/sce/contact

**Additional information relating to SIMATIC PCS 7 and SIMIT**
In particular, Getting Started, videos, tutorials, manuals and programming guide. siemens.com/sce/pcs7

**Additional information relating to SCE**
siemens.com/sce

**Note on Usage**
The training curriculum for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes at public educational and R&D facilities. Siemens AG is not liable for the contents.

This document may only be used for initial training on Siemens products/systems. This means it may be copied entirely or partially and handed to trainees for use within the scope of their training. Passing on or copying this document and communicating its contents is permitted within public training and continuing education facilities for training purposes.

Exceptions require written permission by Siemens AG. Contact person: Roland Scheuerer roland.scheuerer@siemens.com.

Violators are subject to damages. All rights including translation rights are reserved, particularly in the event a patent is granted or a utility model or design is registered.

Usage for industrial customer courses is explicitly not permitted. We do not agree to the commercial utilization of these documents.

We would like to thank the Technical University Dresden, particularly Prof. Dr. Leon Urbas and Annett Krause, MS, as well as the Michael Dziallas Engineering Corporation and those who provided support in preparing this SCE training document.
**BATCH CONTROL WITH RECIPES**

**TRAINING OBJECTIVE**

In this chapter, the students learn to model a production batch process hierarchically. They can define recipes for control of batch plants and production of batch products including the necessary process steps and implement these afterwards in the PCS 7 control system.

**THEORY IN BRIEF**

Industrial manufacturing processes can be generally classified as continuous processes, processes with unit production or batch processes. Batch processes result in the continuous production of finite amounts of products (batches), in which quantities of input materials with the use of one or more devices are subject to a defined sequence of processing activities (*process operations, process steps*). In this module we are looking at the computer-generated mapping of a specified sequence and automation of batch processes through *recipes*.

![Chronological sequence of a batch process](image)

Figure 1: Chronological sequence of a batch process

General and site recipes are sources of information for the creation of plant-specific master recipes; they provide production information without reference to specific production equipment.

They describe the materials, the requirements for the devices as well as the necessary chemical and physical transformations for manufacturing of a product in form of a production rule.

A batch production log includes information on batch production and associated business information. A batch production log is generated to meet a business requirement. The contents of a batch production log are specified by the business requirement.
**THEORY**

**HIERARCHICAL MODELING**

The batch processes in the process industry include a large number of devices, the process steps that can be executed on them and, therefore, create a wide variety of products. To manage the sheer quantity, it is therefore useful to structure the world of batch processes hierarchically; it will serve as a basis to reuse blocks and components that have already been developed on different levels.

A process consists of one or multiple process stages that are organized as structured group and can run in series or parallel or both at the same time. A process stage is part of a process that should best run independent of other process stages. Each process stage consists of a structured group of one or multiple process operations. Process operations describe connected processing activities that are necessary to achieve a milestone. Each process operation can be subdivided into a structured group of one or multiple process steps which execute the processing required for the process operation. Process steps describe smaller, reusable processing processes that are combined to form a process operation.

**CONCEPTS OF THE BATCH-BASED CONTROL STRATEGY**

**Basic control**

Basic control includes the control that is to bring about and maintain a specific operating state of the devices and the process. Basic control includes closed control loops, interlocks, monitoring, exception handling, and repeatable discrete controls or procedural controls; it can respond to process conditions that impact the control outputs or could trigger corrective actions; it can be enabled, disabled or modified by instructions of the operator, through procedural controls or coordination controls (see modules P01-04 to P01-08).

**Procedural control**

Procedural control determines that equipment-based actions take place in a structured sequence so that a process-based task is executed. Procedural controls are characteristic for batch-based processes. They are a type of control that enables devices to execute a batch process.

![Procedural control model with example](image)

*Figure 2: Procedural control model with example [3]*
Procedure

The procedure is the highest level in the hierarchy; it specifies the strategy for executing a comprehensive processing action, such as the production of a batch. It is determined by an ordered set of unit procedures. One example for a procedure is "Produce product".

Unit procedure

A unit procedure consists of an ordered set of operations which cause a connected production sequence to take place in a unit. We assume that only one operation is active in a unit at any time. An operation is completely executed in a single unit. However, multiple unit procedures can take place in a procedure concurrently, each in a different unit.

Operation

An operation is an ordered set of functions that specify a larger processing sequence; they cause the materials to be processed to transition from one state to another which usually involves a chemical or physical change. It is often desirable to place the limits of an operation at points in the procedure where normal processing can be safely interrupted.

Examples for operations are:

- Preparation: Evacuate and clean reactor.
- Fill: Add distilled water and solvent.
- Reaction: Add and heat educt1 and educt2.

Function

A function is the smallest element of a procedural control that can execute a process-oriented task. A function can be subdivided into smaller parts. The steps and transitions as described in IEC 60848, document a method to define subdivisions of a function. A step can output one or multiple instructions or cause one or multiple measures, for example:

- Switching on and off closed control loops and state-oriented types of basic control, and specification of their setpoints and initial values;
- Setting, deleting and changing of alarm limits and other limit values;
- Setting and changing of control constants, control modes and types of algorithms;
- Reading of process variables, such as gas density, gas temperature and volume flow from a flowmeter, and calculating the mass flow through the flowmeter;
- Checking the operator authorization.

Execution of a function can result in:

- Commands to the basic control,
- Commands to other functions (either in the same or a different equipment entity) and/or
- Collection of data.

The goal of a function is to bring about or define a process-oriented action, whereas the logic or the sequence of steps that make up a function is device-specific. Here are some examples of functions:

- Stirring
- Dosing
- Heating
**Recipes and Recipe Types**

It makes a lot of sense for a company with many production sites to create standardized recipes that are in effect for all sites and define exactly how a batch product is to be created. Because chemical plants are usually solitary operations for cost reasons due to the mandatory adaptation to the local situation regarding power and educt supply, structures are necessary that

a) enable an abstract definition mostly independent of the specific plant as well as

b) an easy adaptation and mapping to the specific equipment.

Thus the option exists to finally get from a still very abstract general recipe, via the site and master recipe, to a concrete control recipe.

**General Recipe**

The general recipe is a recipe on the enterprise level that serves as a basis for recipes on the lower levels. The general recipe is created without specific knowledge of the plant equipment that is going to be used to manufacture the product. It determines the raw materials, their relative quantities and the required processing, however, without reference to a specific factory or the equipment available in this factory. It is created by persons who are familiar with the chemistry and the processing requirements that are typical for the respective product and reflects their interests and thoughts.

**Site Recipe**

The site recipe is specific to a specific factory. It is a combination of factory-specific information and the general recipe. It is usually derived from a general recipe to meet the requirements of a specific production site and offers a level of detail required for factory-related, long-term production planning.

**Master Recipe**

The master recipe is the recipe level that is geared towards a plant or a group of equipment in a plant. A master recipe can be derived from a general recipe or the site recipe. It can also be created as an independent unit when the recipe creator has access to the information that is generally made available in the general recipe or in the site recipe.

SIMATIC Batch distinguishes here between flat and hierarchical recipes. This subdivision gives you the option to build recipes on one another.
Control recipe

The control recipe is created as a copy of a specific version of the master recipe; it is subsequently modified as necessary through information for disposition planning and execution to make it specific for an individual batch. It includes product-specific process information as it is required for the production of a specific batch. It offers the level of detail as required for the start and monitoring of the equipment procedure objects of a plant. It may have been modified to reflect the actual raw material qualities and the actually used equipment. The selection of units and corresponding scaling can take at any time before this information is required.

Because changes to the control recipe based on information regarding production planning, equipment and plant operators can be made for quite some time, a control recipe may be subject to multiple changes during the batch production.

Application in PCS 7

A simplified model with two types of recipe is used in SIMATIC BATCH:

- Master recipe
- Control recipe

![Diagram showing the difference between master recipe and control recipe](image)

Figure 4: Difference between control recipe and master recipe [3]
**Physical Model**

![Diagram of physical model](image)

Figure 5: Physical model with example [3]

**Process cell**

A process cell is the combination of all equipment for the production of a batch. The line is a frequently encountered subset of process cells. A line is a combination of all units and other devices that can be used by a specific batch. Lines can remain the same from batch to batch or they can be modified for each batch.

**Unit**

A unit consists of equipment modules and individual control units. A unit is an independent device group usually arranged around a larger processing device such as a stirrer tank or a reactor. Characteristics of a unit:

- A unit can execute one or multiple processing activities such as reaction, crystallization or solution.
- Units largely work independently of one another.
- A unit frequently includes a complete batch at a specific point in the processing sequence of the batch.
- A unit can never process more than one batch at a time.

**Equipment module**

An equipment module can consist of individual control units and subordinate equipment modules. An equipment module is usually arranged around a part of a processing equipment, such as a filter.

Characteristics of an equipment module:

- Can be part of a unit or an independent equipment group within a process cell
- Can execute a finite number of specific smaller processing activities, such as dosing and weighing
- Does not have to but can include the raw materials of a batch
**Individual control unit**

An individual control unit is a combination of measuring devices, actuators and other individual control units as well as the associated processing equipment that is operated as an individual unit as far as control engineering is concerned.

An individual control unit can also be made up of other individual control units. A dosing individual control unit, for example, could be a combination of multiple automatic switching valve individual control units.

There is no mapping for the individual control unit in the procedural model and in the process model.

This means it cannot be addressed in **SIMATIC BATCH**.

---

**MONITORING & EVALUATION**

A crucial element of batch production is the collection and archiving (for example, with StoragePlus or a Central Archive Server) of the production data. The data is required for official requirements regarding traceability of the produced batch as well as for the operational analysis of the production process. It is important in this regard to save the continuously generated process data (temperatures, pressures, etc.) as well as the event-related process and status information and to have it at hand for a correlative evaluation.

The most basic form of documentation is the batch report. In addition to the recipe specifications and the actually produced actual data, it usually includes the runtimes of the procedure modules (start, end) and any additional process and operating checkback signals, if available. Depending on the market segment (pharma, food), a tamperproof historization and archiving of data must be proven.

---

**SPECIAL CHARACTERISTICS**

Due to the procedural requirements of a BATCH control on a PCS7 project, a basic control as it was carried out until now cannot be transferred to a BATCH project. This distinction is made with the help of SFC types or the configuration of individual CFCs for each function. It is necessary for both versions to identify any interruption option and to bring them to a defined state in a downstream shutdown routine. Additional information on this type of configuration is available in [3].

---

**LITERATURE**


STEP BY STEP INSTRUCTIONS

TASK

Similar to the recipe from the chapter 'Sequential Control Systems', we want to create and program a batch control recipe for the production of a batch.

For this chapter, the recipe is reduced to the following sequence:

1. First, 250 ml will be drained from the educt tank =SCE.A1.T1-B001 to the reactor =SCE.A1.T2-R001.
2. Then 150 ml will be drained from the educt tank =SCE.A1.T1-B002 to the reactor =SCE.A1.T2-R001.
3. The liquids in the reactor =SCE.A1.T2-R001 are now stirred with the stirrer for 20 seconds.
4. Finally, this mixture will be drained to the product tank =SCE.A1.T3-B001.

TRAINING OBJECTIVE

In this chapter, the student learns the following:

– Setting up batch components
– Adapting the structure for production of a batch in the plant view
– Creating output and input materials in the SIMATIC Batch Control Center
– Creating a control recipe in the SIMATIC Batch Control Center
– Creating, releasing, starting a batch in the SIMATIC Batch Control Center

PROGRAMMING

1. As source project you will use a project that already includes all CFC and SFC blocks that you need later for the production of batches with the SIMATIC Batch Control. This project is now retrieved at the beginning in the SIMATIC Manager. (→ File → Retrieve)
2. As template we are using the project ‘PCS7_SCE_0303_Vorl_R1505_en.zip’. 
(→ PCS7_SCE_0303_Vorl_R1505_en.zip → Open)

3. Next, click the icon to start the PLC simulation S7-PLCSIM. (→)

4. In S7-PLCSIM, select ‘PLCSIM(TCP/IP)’ as interface and check if ‘PLCSIM(TCP/IP)’ is also set in the SIMATIC Manager. (→ PLCSIM(TCP/IP))
5. Now select the 'Object Properties' of the PC station that includes an Operator Station (here: OS). (→ OS → Object Properties)
6. In the general properties under 'Computer name' enter the local computer name. 
   (→ Computer name: Local computer name → OK)

   ![Image of properties window]

   **Note:** The generated batch process cell data is also loaded to this computer later.

7. Now start the WinCC Explorer by selecting under OS → WinCC Appl. → OS(1) 'Open
   Object'. (→ OS(1) → Open Object)

   ![Image of WinCC Explorer window]
8. In the Explorer, select the 'Properties' of the 'Computer'. (Computer → Properties)

9. Then click the 'Properties' of the computer once again. (Properties)
10. In the next dialog, click 'Use Local Computer Name' for Computer Name (→ Use Local Computer Name → OK)

11. Exit the Explorer and close the project. (→ File → Exit → OK)
12. To create the batch components, you select the PC station and open the configuration. (→ OS → Configuration)
13. In the hardware configuration you drag the 'BATCH Application' from the catalog in the folder 'SIMATIC PC Station/BATCH' to slot 3. (SIMATIC PC Station → BATCH → BATCH Application)

14. You drag the 'BATCH Application Client' to slot 4. Then you 'save and compile' the modified configuration and close the application.

(→ SIMATIC PC Station → BATCH → BATCH Application Client)

Notes:
- A 'BATCH Application' must be configured in the hardware configuration for each PC on which a batch server application is running.
- If the batch server and the batch client are to run on one PC, you set up a 'BATCH (Server) Application' and a 'BATCH Application Client' in the hardware configuration. Enter the name of the local PC as runtime computer name.

- A batch client can also run on a PC station on which no Operator Station is installed.

15. In the following steps, the S88 Type Definition of the corresponding folders takes place in 'Process cell' and 'Unit'. To do this, you change to the plant view, highlight the folder 'A1_multipurpose_plant' and select its properties. (→ View → Plant View → A1_multipurpose_plant → Object Properties)

16. Under the item 'S88 Type Definition', you enter 'Process cell' for this folder. (→ S88 Type Definition → Process cell → OK)
17. In the entire third hierarchy level, you enter the S88 Type Definition 'Unit'. (→ S88 Type Definition → Unit → OK)

18. As a result the S88 Type Definitions 'Process cell' and 'Unit' should be allocated as seen below.
19. Our project already includes three SFC types. These can be found in the component view in the 'Charts' folder of the SIMATIC 400 station. The SFC type 'Filling' is used for filling the reactors from the educt tanks, the SFC type 'Emptying' is used to empty the reactors, and 'Stirring' is used for stirring the reactors.

![SIMATIC Manager - PC97_SCE_MP (Component view) - 01/SCE_Projects/en/PC97_SCE/PC97_MP.png](attachment:image_url)

20. Our project already includes CFCs and SFCs so that these three SFC types are already instantiated. You must still assign a batch category to the SFC types in the 'Object Properties' so that the S88.01-relevant information for batch is later created automatically during type generation. In the Options you now assign the batch category 'EPH', allow operator instructions and enable the possible control strategies. (→ Filling → Object properties → Options → Category: EPH → Allow operator instructions → Control strategy selection: Filling_R001 and Filling_R002 → OK)
Note: The category ‘EPH’ defines the SFC type as Equipment Phase in batch. Both of our SFC types are equipment phases that terminate automatically.

21. The category ‘EPH’ is also assigned to the SFC types ‘Emptying’ and ‘Stirring’.

(→ Emptying/Stirring → Object properties → Options → Category: EPH → Allow operator instructions → Control strategy selection: … → OK)
22. Next, we compile the AS and OS in the project as shown in the figure below.

Refer to the log for the single objects for more information.
23. In the following steps we will make the settings for batch. To do so, select the multiproject in the ‘Plant View’. (→ Plant View → SCE_PCS7_MP → SIMATIC BATCH → Open configuration dialog...)

![SIMATIC Manager - SCE_PCS7_MP (Plant View) - DiSCE_Projects_en_PCST_SCE_PCS7_MP.png](image1)

![Batch configuration.png](image2)
24. First there is a check to determine if a format conversion is needed. (→ OK → Start → Close)
25. The batch types are now propagated and thus distributed to the individual projects of the multiproject. (→ Batch types → Propagate)

![Propagate Batch Types](image)

**Note:** If the button is grayed out, close the dialog with 'OK' and open the configuration first in one of the hierarchy folders, e.g. ‘A1_multipurpose_plant’. Close the dialog again with ‘OK’ and open the configuration once again on the multiproject level. The button should now be enabled.

26. Select the project, click ‘Start’ and then ‘Close’. (→ SCE_PCS7_Paj → Start → Close)

![Start and Close Propagation](image)
27. Now we can generate the batch types. (→ Batch types → Generate)

28. We select our project, click 'Start' and then 'Close'.
   (→ SCE_PCS7_Prj → Start → Close)
29. The three ‘Phase types’ ‘Emptying’, ‘Filling’ and ‘Stirring’ from the project are now visible.

30. Next, select the ‘Batch instances’ to show the assignment of the archive tags with ‘Merge’ in the multiproject. (Batch instances → Merge)
31. We select our project, click 'Start' and then 'Close'. (→ SCE_PCS7_Prij → Start → Close)

32. You can now take a look at the created instances under 'Batch instances'. Errors and warnings can be displayed under 'Log' just as in the previous steps. (→ Log → Display → OK)
33. The following errors are detected.

![Image of error detection in BATCH configuration]

34. To remedy this error, close the BATCH configuration with 'OK' and add a CFC with a UNIT_Block (UNIT_PLC) to the folder 'rinsing_tank B001'. To do so, create a new CFC and call it 'A1T4B001_UNIT'. Now add a UNIT_Block from the blocks or the SIMATIC BATCH Blocks library. Label the block A1T4B001.

![Image of CFC creation in BATCH configuration]

**Note:** If you were to start the BATCH configuration and the merging of the batch instances once again, you would definitely receive warnings that are generated because the AS and OS were not compiled after inserting the blocks.
35. The next step therefore is the compilation of all objects which also removes the warnings.  
(→ SCE_PCS7_MP → PLC → Compile and Download Objects...)

36. The object 'A1_multipurpose_plant' has been added in the following dialog. Select 'Compile' and 'Download' for all components as shown below. In row 'A1_multipurpose_plant', click 'Edit' for the compilation and download settings.  
(→ A1_multipurpose_plant → Edit)
37. In the window 'Merge/Compile', select 'Generate types before compilation'. 
(→ Merge/Compile → Generate types before compilation)

![Image of Merge/Compile settings]

38. For 'Transferred', select 'Transfer messages'. 
(→ Transferred → Transfer messages)

![Image of Transferred settings]
39. For 'Download', select all components that can be selected.

(→ Download → OK)

![Download settings](image)

40. Now, click 'Start' in 'Compile and Download Objects' and confirm the message windows as seen in the previous chapters. (→ Start → Close)

![Compile and Download Objects](image)

**Note:** If another project has already been loaded, you must also restart the PC. Otherwise, the other project remains loaded, and you have no access to the batch data.
41. Now open the OS. (→ OS(1) → Open Object)

42. In the Explorer you must create a user for batch in 'User Administrator'.

(→ User Administrator → Open)
43. Under 'Administrator-Group', create a user with the login: 'scebatch' and a password 'scebatch'. (→ Administrator-Group → New User → scebatch → scebatch → OK)
44. Now enable all options for A1_multipurpose_plant.

45. Then exit the User Administrator. (→ File → Exit)
46. Now you still have to check your screen resolution. Open the 'OS Project Editor' to do so. (→ OS Project Editor → Open)

47. To test our recipe later more or less realistically, start the SIMIT Simulation with a double-click on the PC desktop. (→ SIMIT-SCE-PA-Demo 7)

48. Now set the CPU in S7-PLCSIM to RUN-P and activate the runtime in the WinCC Explorer. (→ S7-PLCSIM → RUN-P → Activate)
49. Enter 'scebatch' as login and password in our example. (→ scebatch → scebatch → OK)

50. If all settings you have made so far are correct, the 'BATCH Launch Coordinator' is automatically displayed in the taskbar with the status of the batch applications.
51. If this should not be the case, you can also start it manually. (→ Start → SIMATIC → BATCH → BATCH Launch Coordinator)

52. Depending on the settings, SIMATIC BATCH is started automatically after the OS is started, and your work is done here. If you still want to manipulate the process, you can do so with a right click on the icon in the taskbar and start up or shut down BATCH manually.

53. In Runtime, you click the icon to switch to the second set of keys. There you start the Batch Control Center by clicking.
54. If not all start conditions for the BATCH Control Center are met, you will be informed about it in a display. For example, here the SIMATIC BATCH application has not been started yet. In this case, close the OS application, establish the start conditions and start the BATCH Control Center again. (→ Close application)

55. First you have to log in. To do so, use your login information for the computer (here: plt-admin).

**Note:** If Simatic Logon has not been installed yet, steps 55-59 are obsolete. Before you continue with the instruction, install the SIMATIC Logon Service.
56. Then open the ‘Roles management’ under 'Options'.

![Roles management](image1)

**Note:** If *Roles management* is grayed out, note the following: User must be a member of the Windows user group *Logon_Administrator*. Make this setting now.

57. In the ‘Super user’ role, right-click ‘Groups and users’ to open the menu command ‘Edit’.

![Groups and users](image2)
58. In the next dialog, click on 'List' and then select your user. You add yourself to the role with the arrow key.
59. Exit the dialog with 'OK'. Then you must save your changes and close Roles Management.
60. Next, select the item 'New process cell...' in the 'Program' menu. The 'A1_multipurpose_plant' is added to the project.

![SIMATIC BATCH Control Center](image)

**Note:** If batch data is still present, you can delete them with the steps from the following instruction: [http://support.automation.siemens.com/WW/view/en/18794587](http://support.automation.siemens.com/WW/view/en/18794587). Then restart.

61. Now open the menu of the process cell to specify the new input and output materials for the recipes. (→ Materials → New)

![SIMATIC BATCH Control Center](image)
62. First you enter 'Educt001' with the code 'E001' and usage as 'Input material'.

\[ \text{Educt001} \rightarrow \text{E001} \rightarrow \text{Input material} \rightarrow \text{OK} \]

63. You then enter 'Educt002'/'Educt003' as additional input materials.

\[ \text{Materials} \rightarrow \text{New} \rightarrow \text{Educt002/Educt003} \rightarrow \text{E002/E003} \rightarrow \text{Input material} \rightarrow \text{OK} \]
64. Define 'Product001' with the code 'P001' as 'Output material'. (Materials → New → Product001 → P001 → Output material → OK)

65. Now you create a new 'Master recipe'. Our recipe is to be of the type 'Flat' so that the unit class/unit can be assigned individually to each recipe step. (Master recipe → New → Flat)
66. You name the recipe 'Recipe_Product001'. (→ Recipe_Product001 → OK)

67. Now you open the properties of the recipe.  
(→ Recipe_Product001 V1.0 → Properties)
68. First you specify the assignment by clicking 'New' in the corresponding tab. Enter the unit 'Educt_tank_B001' as name for the first recipe assignment. Then select 'Edit'.

![Image of software interface for recipe assignment]

69. Select 'educt_tank B001' in the equipment selection and in the preferred unit and confirm your selection with 'OK'.

![Image of software interface for equipment selection]
70. Repeat steps 68 and 69 for the other units as shown in the figure below.

71. Next you first define a product with product code, reference quantity, unit of measure, minimum and maximum quantity of a batch. (→ Product → Product: Product001 → Product Code: P001 → Reference quantity: 400 → Unit of measure: ml → Minimum quantity of a batch 300 → Maximum quantity of a batch 1000)
72. Then you define the first input material. (→ Input material → New)

73. Once you have named it, the material Educt001 is selected. (→ Name: Input material 1 → Material → Educt001 → OK)
74. After you have selected the second material, Educt002, you also specify the quantity and the unit of measure of the input materials. (→ Name: Input material 2 → Material → Educt002 → OK → Quantity: 250 → Quantity: 150 → Unit of measure: ml → Unit of measure: ml)
75. Then you define the output material. (→ Output material → New)

76. After you have selected the output material, you also specify its quantity and unit of measure. (→ Output material → Name: Output material → Material → Product001 → OK → Quantity: 400 → Unit of measure: ml)
77. Now open the recipe. (→ Recipe_Product001 V1.0)

78. The recipe is created in a recipe editor. Here you can create linear and parallel structures as well as loops. Our recipe is linear and consists of 4 recipe operations. Now add four 'recipe phases/recipe operations' with drag&drop. (→ Insert recipe phase/recipe operation)
79. Change the mode to 'Select'. (→ Select)

80. Now select the first recipe phase/recipe operation and select its properties. (→ NOP → Properties)
81. In the properties under ‘General’ select the unit ‘Educt_tank_B001’ and the phase ‘Filling (EPH)’ with the control strategy ‘Filling’. (→ General → Unit name: Educt_tank_B001 → Phase: Filling (EPH) → Control strategy: Filling_R001)

82. Under ‘Parameters’, select the value 250 ml for the ‘Filling quantity’. (→ Parameters → FillingQuantity → 250 → OK)
83. Now this recipe phase/recipe operation is given a comment.
(→ Add comment → Filling of reactor R001 from educt tank B001 → OK)

84. We are also setting up the second recipe phase/recipe operation with the preferred unit 'Educt_tank_B002', the phase Filling (EPH) and the control strategy Filling_R001. For 'FillingQuantity', select the value 150 ml.
85. You set up the third recipe phase/recipe operation with the preferred unit 'Reactor_R001' and the phase Stirring (EPH) with control strategy 'Stirring'. For 'Duration', select the value 20s.

86. You set up the fourth recipe phase/recipe operation with the preferred unit 'Reactor_R001', the phase Emptying (EPH) and the control strategy 'Emptying'. You do not have to assign any parameters here.
87. Once you have labeled the recipe phases/recipe operations as seen here, you save the recipe.

88. Next, you should check the recipe for validity before you close it. (→Recipe→Check validity→OK)
89. Now the 'Recipe_Product001 V1.0' is released for production.

(→ Recipe_Product001 V1.0 → Release for production)

90. Next, you enter a new order folder. (→ Orders → New)

91. You name the order folder 'SCE_orders'. (→ SCE_orders → OK)
92. You create a new order in the new order folder. (→ SCE_orders → New)

93. You name the order 'order01'. (→ order01 → Batches)
94. You create a new batch in the order. (→ New)

95. You assign the 'Recipe_Product001 V1.0' to the batch. (→ Recipe_Product001 V1.0 → OK)
96. For each batch you can specify the product and the quantity, and select parameters. (Product: Produkt001 → Quantity: 400 → Parameter)

97. If multiple units are available for specific recipe allocations, you can specify these under 'Allocations'. (Allocations)
98. The used materials and their quantities can be set under 'Input material'.

(→ Input material → Quantity: 250 → Quantity: 150)

99. The output material and its quantity are selected under 'Output material'.

(→ Output material → Quantity: 400 → OK → OK)
100. Now you open the control recipe for the 'Batch' to monitor and start it at a later time. 
(→ Batch → Open control recipe)

101. Now release the batch. (→ Batch → Release → Yes)
102. Start the process by clicking \( \rightarrow \) Start batch \( \rightarrow \) Yes.

103. Now you can monitor the processing of the recipe. With the commands in the menu bar you can stop, hold, restart or cancel the recipe.
104. In Runtime, you can view the allocation of the objects by the batch in the 'Batch' view of the faceplates. (→ Batch)

105. Once a batch has been completely processed, it must still be closed to collect the batch-specific measured values and message data and write them to the hard drive. (→ Batch → Close)
106. You can view the production data under 'Properties'. Exit the BATCH CONTROL Center.
EXERCISES

In the exercises, we apply what we learned in the Theory section and in the Step by Step Instructions. The existing multi-project from the step by step instructions (PCS 7_SCE_0303_R1505_en.zip) will be used and expanded for this.

Note: The project PCS 7_SCE_0303_R1505_en.zip can only include the contents of the step by step instruction up to step 48; all other steps have to be executed manually. You can restore the steps 60 to 89 by restoring the backup PCS7_SCE_0303_Batch_Backup_R1505_en.sbb, if the process cell was reset. The steps starting at 90 must be executed manually.

The steps 67 to 89 (control recipe only) can be restored by importing the file PCS7_SCE_0303_Export_Rezept_R1505-en.sbx.

Note: All previous batch data is to be deleted due to possible overlaps with other projects.

EXERCISES

The following exercises are based on the step by step instructions. The corresponding steps of the instruction can be used to assist with each exercise.

1. Implement a new material, Product002 (P002), in the Batch Control Center.
2. Create a new master recipe 'Recipe_Product002' with the following properties:

<table>
<thead>
<tr>
<th>Allocation</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Educt_tank B001</td>
<td>Product002</td>
</tr>
<tr>
<td>Educt_tank B002</td>
<td>500ml / 300ml / 1000ml</td>
</tr>
<tr>
<td>Educt_tank B003</td>
<td>Input material</td>
</tr>
</tbody>
</table>
   | Reactor R002        | Input material 1
   |                     | E001 (150 ml) |
   |                     | Input material 2
   |                     | E002 (250 ml) |
   |                     | Input material 3
   |                     | E003 (100ml)  |
   | Output material     | Output material 1
   |                     | Product002 (500ml) |

3. Now create the following recipe:
   - First, 150 ml will be drained from educt tank =SCE.A1.T1-B001 to the reactor =SCE.A1.T2-R002.
   - Then 250 ml will be drained from the educt tank =SCE.A1.T1-B002 to the reactor =SCE.A1.T2-R002.
   - Then 100 ml are drained from the educt tank =SCE.A1.T1-B003 to the reactor =SCE.A1.T2-R002.
   - The liquids in the reactor =SCE.A1.T2-R002 are now stirred with the stirrer for 10 seconds.
   - Finally, this mixture will be drained to the product tank =SCE.A1.T3-B002.

4. Check the validity of the recipe and release it for production.
5. Create an Order02 and edit the batch of the Product002.
6. Release the batch, open the control recipe and start production.
7. Finally, close the batch.